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Sl. No. Topic No. Of MCQ 

1 Shortcut Key & Full Form 520 

2 Internet and its Services 517 

3 MS Excel 357 

4 MS Word 457 

5 MS PowerPoint 196 

6 Computer Hardware & Software 281 

7 Computer Memory 221 

8 Miscellaneous 402 

9 Data Communication and Networking 235 
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12 Windows 97 

13 Database Concepts 38 

14 Computer Security 62 

15 Basic & Introduction 127 

16 Input And Output Device 88 

17 MS Access 38 
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OSSSC Previous Year Questions (PYQ) 
Sl. No. Exam Name Year 
1 OSSSC LSI, FG, FORESTER 2024 (All 42 Shifts) 

2 OSSSC RI 2015, 2021 

3 OSSSC PEO & JA 2023 

4 OSSSC CRE (ARI, AMIN, SFS, FG, EXCISE 

CONSTABLE) 

2022 

5 OSSSC JUNIOR CLERK 2015, 2017, 2018 

6 OSSSC LSI 2021 

7 OSSSC ICDS Supervisor 2016 

8 OSSSC Excise Constable 2014, 2019 

9 OSSSC VAW 2016 

10 OSSSC Jr. Stenographer 2015 

11 OSSSC Laboratory Technician 2021 

12 OSSSC MPHW 2023 

13 OSSSC Nursing 2020, 2023 

14 OSSSC SFS 2016 

15 OSSSC Pharmacist 2020 

16 OSSSC Radiographer 2020 
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OSSC Previous Year Questions (PYQ) 
Sl. No. Exam Name Year 
1 OSSC ATO 2024 

2 OSSC CHSL Specialist 2024 

3 OSSC Assistant Sub-Inspector 2022 

4 OSSC Accountant 2022 

5 OSSC AMIN 2023 Pre & Mains 

6 OSSC BSSO 2022 (All 18 Shifts) 

7 OSSC CGL 2022 (All 18 Shifts) , 2023, 

2024 

8 OSSC CHSL 2023 

9 OSSC CPGL 2023 

10 OSSC CTS 2023, 2024 

11 OSSC ESI 2023 

12 OSSC GPEO 2015 

13 OSSC Investigator 2022 (All 3 Shifts) 

14 OSSC WEO 2022 

15 OSSC JEA 2022 (All 16 Shifts) 

16 OSSC Junior Assistant 2022 (All 10 Shifts) 

17 OSSC Junior Clerk 2022 

18 OSSC SCEW 2022 (All 5 Shifts) 

19 OSSC SFS 2016 

20 OSSC Specialist 2023 

21 OSSC Stenographer 2023, 2024 

22 OSSC Supply Inspector 2017 

23 OSSC WEO 2022 (All 21 Shifts) 
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Odisha Police & Defence Previous Year Questions (PYQ) 
Sl. No. Exam Name Year 
1 Odisha Battalion / OSAP 2017 

2 Odisha Police Constable 2011, 2012, 2013, 2018, 

2023 

3 Odisha Fireman 2023 

4 Odisha Jail Warder 2022 (All 18 Shifts) 

5 OPRB SI Police 2016, 2017, 2019, 2022 

(All 11 Shifts), 2023 

6 OSSC Excise SI 2021 (All 9 Shifts), 2022 

7 OSSC Traffic Constable 2022 (All 6 Shifts) 

8 OSSC Traffic SI 2022 (All 4 Shifts) 
 

 

OPSC Previous Year Questions (PYQ) 
Sl. No. Exam Name Year 
1 OPSC Jr. Assistant 2024 
2 OPSC ASO 2014, 2015, 2019, 2022 
3 OPSC OMAS 2019, 2023 
4 OPSC OAS Only Odisha GK Taken 

From All Previous Year 
Preliminary Exams 

5 OPSC Assistant Director Of  Factory & Boiler 2023 Pre (Only Odisha GK 
Taken) 

6 OPSC Asst Director Handicraft 2023 Pre (Only Odisha GK 
Taken) 

 

Odisha High Court Previous Year Questions (PYQ) 
Sl. No. Exam Name Year 
1 OHC ASO 2021, 2023, 2023 (ST 

Special) 
 

Odisha Forest Development Corporation Previous Year Questions (PYQ) 
Sl. No. Exam Name Year 
1 OFDC Field Assistant 2021 
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Odisha Teaching Exams Previous Year Questions (PYQ) 
Sl. No. Exam Name Year 
1 CT 2018 (All 23 Shifts) 

2019 (All 24 Shifts) 
2020 (All 20 Shifts) 
2023 (All 11 Shifts) 

2 OTET 2022 
3 JT 2023 (All 14 Shifts) 
4 B.ED Entrance Exam  

ARTS & SCIENCE 2018 (All 11 Shifts) 
2019 (All 15 Shifts) 
2020 (All 13 Shifts) 
2021 (All 15 Shifts) 
2022 
2023 

6 OSSTET (ARTS, CBZ & PCM) 2018, 2019, 2021 (1st), 
2021 (2nd ), 2022, 2024 

7 SSB (ARTS, CBZ & PCM) 2024 
8 RHT / High School Teacher   

 RHT  ARTS 2019 
2021 (All 3 Shifts) 
2022 (All 6 Shifts) 
2023 Pre (All 3 Shifts) 
2023 Mains 

 RHT  CBZ 2019 
2021 
2022 (All 3 Shifts) 
2023 Pre (All 3 Shifts) 
2023 Mains 

 RHT  PCM 2019 (All 2 Shifts) 
2021 (All 2 Shifts) 
2022 (All 4 Shifts) 
2023 Pre (All 3 Shifts) 
2023 Mains 

9 OAVS  
OAVS TGT ODIA 2018, 2019, 2021 
OAVS TGT ENGLISH 2019 
OAVS TGT SOCIAL STUDIES 2019, 2021, 2023 
OAVS TGT SCIENCE 2019, 2021 
OAVS TGT MATH 2019, 2023 
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Topic Name-  “ MS Word ” 
 

1- What is MS Word? 

ଏମଏସ ୱାଡ� କ'ଣ?  

 

[A] A big word 

[B] A dictionary 

[C] A word processor 

[D] A computer name 

[Odisha District Police Constable 2023] 

 

Ans-  C 

MS Word, short for Microsoft Word, is a popular word processing 
software developed and published by Microsoft Corporation. It is a part 
of the Microsoft Office suite, which includes other popular software 
applications like Excel, PowerPoint, and Outlook. 

ମାଇେ�ାସ�� ୱାଡ� ପାଇ ଁ ସଂ�ି� ଏମଏସ ୱାଡ�, ଏକ େଲାକ�ିୟ ଶ� ��ିୟାକରଣ 
ସ��େୱୟାର ଯାହା ମାଇେ�ାସ�� କେପ�ାେରସନ �ାରା ବିକଶତି ଏବଂ �କାଶତି । ଏହା 
ମାଇେ�ାସ��  ଅଫିସ ସଇୁଟ୍ ର ଏକ ଅଂଶ, େଯଉଥଁ �େର ଅନ� େଲାକ�ିୟ ସ��େୱୟାର୍ 
ଆ�ି �େକସନ୍ େଯପରିକି Excel, PowerPoint ଏବଂ Outlook ଅ�ଭ�ୁ �। 
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2- Word processing, Spreadsheet, and photo-editing are examples 
of 

- ୱାଡ� େ�ାେସସିଂ, େ��ଡସିଟ୍ ଏବଂ ଫେଟା-ଏଡିଟିଂ ____ର  ଉଦାହରଣ  

 

A. application software 

B. system software 

C. operating system software 

D. platform software 

[Odisha Jail Warder 2022]  

 

Ans-  A 

Word processing, spreadsheet, and photo-editing are examples of 
software applications 

Word processing software like Microsoft Word, Google Docs, or 
LibreOffice Writer is used for creating, editing, and formatting text-based 
documents such as letters, reports, and resumes. 

Spreadsheet software like Microsoft Excel, Google Sheets, or 
LibreOffice Calc is used for organizing, analyzing, and manipulating 
data in the form of rows and columns. 

Photo-editing software like Adobe Photoshop, GIMP, or PaintShop Pro 
is used for editing and manipulating digital images, including resizing, 
cropping, adjusting color, and adding effects. 
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ୱାଡ� େ�ାେସସିଂ, େ��ଡସିଟ୍ ଏବଂ ଫେଟା-ଏଡିଟିଂ େହଉଛି ସ��େୱର ଆ�ି�େକସନ୍ ର 
ଉଦାହରଣ 

 ମାଇେ�ାସ�� ୱାଡ�, ଗଗୁଲୁ ଡ�, କି� �ା ଲିେ�ଅଫିସ ରାଇଟର ଭଳି ୱାଡ� େ�ାେସସିଂ 
ସ��େୱୟାର ଅ�ର, ରିେପାଟ� ଏବଂ ରିଜୟୁେମ ଭଳି େଟ�ଟ୍ ଆଧାରିତ ଡକୁେମ� ତିଆରି, 
ସ�ାଦନା ଏବଂ ଫମ�ାଟିଂ ପାଇ ଁବ�ବହୃତ ହୁଏ । 

 ମାଇେ�ାସ�� ଏେ�ଲ୍, ଗଗୁଲ୍ୁ ସିଟ୍ ସ କି��ା ଲିେ�ଅଫିସ କାଲ୍ ସି ଭଳି େ��ଡ୍ ସିଟ୍ 
ସ��େୱୟାର୍ ଧାଡ଼ି ଏବଂ �� ଆକାରେର ଡାଟା ସଂଗଠିତ, ବିେ�ଷଣ ଏବଂ ପରିଚାଳନା ପାଇ ଁ
ବ�ବହୃତ ହୁଏ । 

 ଆେଡାବ ଫେଟାସପ,୍ ଜିଆଇଏମପି, କି��ା େପ�ସପ ୍େ�ା ପରି ଫେଟା-ଏଡିଟିଂ ସ��େୱୟାର୍ 
ଡିଜିଟାଲ ଛବିଗଡ଼ୁିକର ସ�ାଦନା ଏବଂ ପରିଚାଳନା ପାଇ ଁ ବ�ବହୃତ ହୁଏ, େଯଉଥଁ �େର 
ପନୁରୁ�ାର, ଫସଲ, ର� ଆଡଜ� କରିବା ଏବଂ �ଭାବ େଯାଡିବା ଅ�ଭ�ୁ � । 

 

 

3- What will Shift + F7 do in a Word application? 

- ଏକ ୱାଡ� ଆ�ି�େକସନେର ସି��  + F7 କ'ଣ କରିବ?  

 

(A) Open the webpage 

(B) Open the hyperlink 

(C) Open the thesaurus  

(D) Open the image 

[OSSC BSSO 2022] 

 

Ans-  C 
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In a Word application, pressing Shift + F7 will bring up the Thesaurus 
pane. The Thesaurus is a tool in Microsoft Word that allows you to find 
synonyms (words with similar meanings) and antonyms (words with 
opposite meanings) for the selected word or phrase. 

ଏକ ୱାଡ� ଆ�ି �େକସନେର, ଶ�ି�  + F7 ଦବାଇେଲ ଥ�େସାରସ ୍େପନ୍  ଆସିବ  । ଥ �େସାରସ 
େହଉଛି ମାଇେ�ାସ�� ୱାଡ�ର ଏକ ଉପକରଣ ଯାହା ଆପଣ�ୁ ଚୟନିତ ଶ� କି� �ା ବାକ� 
ପାଇ ଁ ସମାଥ�କ ଶ� (ସମାନ ଅଥ� ଥ �ବା ଶ�) ଏବଂ ବିେଲାମ (ବିପରୀତ ଅଥ� ଥ �ବା ଶ�) 
େଖାଜିବାକୁ ଅନୁମତି ଦିଏ । 

 

4- To create a newspaper-like layout in your Word document, you 
need to choose _______ option from the Layout tab. 

ଆପଣ� ୱାଡର୍ ଡକୁେମ� (Word document) େର ଖବରକାଗଜ ଭଳ ିେଲଆଉଟ (layout) 

��ୁତ କରିବା ପାଇ ଁ ଆପଣ େଲଆଉଟ ଟ୍ୟାବ (Layout tab) ରୁ _______ ଅପସନ ଚୟନ 

କରିବା ଆବଶ୍ୟକ । 

(A) Border 

 (B) Orientation  

 (C) Column  

 (D) Size 

[OSSC RHT High School Teacher 2023] 

 

Ans-  C 

The Columns option allows you to divide your document into multiple 
columns, just like a newspaper. You can choose the number of columns 
you want, the width of each column, and the spacing between columns. 

�� ବିକ� ଆପଣ�ୁ ଏକ ଖବରକାଗଜ ପରି ଆପଣ� ଡକୁେମ�କୁ ଏକାଧ �କ ��େର ବିଭ� 
କରିବାକୁ ଅନୁମତି ଦିଏ। ଆପଣ ଚାହ ଁୁଥ �ବା �� ସଂଖ�ା, �େତ�କ ��ର �� ଏବଂ �� ମ�େର 
ବ�ବଧାନ ଚୟନ କରିପାରିେବ। 
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5-  How to go to Page number 345 in a MS-WORD document 
containing 465 pages? 

- 465 ପ�ୃ �ା ବିଶ�ି ଏମଏସ-ୱାଡ� ଡକୁ�େମ�େର ପ�ୃ �ା ନ��ର 345କୁ କିପରି ଯିେବ?  

 

A) Press Ctrl + F, then enter 345 and press enter  

B) Press Ctrl+ R, then enter 345 and press enter 

C) Press Alt+G, then enter 345 and press enter  

D) Press Ctrl+G, then enter 345 and press enter 

[OSSSC Junior Clerk 2018] 

 

Ans- D 

• Press the "Ctrl" + "G" keys on your keyboard to open the "Go To" 
dialog box.  

• In the "Go To" dialog box, type in "345" in the "Page" field and click 
on the "Go To" button.  

• MS Word will jump to page 345 in your document. 
•  

• "େଗା ଟୁ" ଡାଏଲଗ ବ�  େଖାଲିବାକୁ ଆପଣ� କୀେବାଡ�େର  "Ctrl" + "G" କୀ  ଦବା�।  
• "େଗା ଟୁ" ଡାଏଲଗ ବ�େର,  "ପ�ୃ �ା" େ��େର "345" ଟାଇପ ୍କର� ଏବଂ "େଗା ଟୁ" 

ବଟନେର �ି�କ୍ କର�  ।  
• MS ଶ� ଆପଣ� ଡକୁେମ�ର ପ�ୃ �ା 345କୁ  େଡଇବଁ। 
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6- _________ option enables you to add common text at the top of 
all the pages in a Word document. 

- _____ ବିକ� ଆପଣ�ୁ ଏକ ୱାଡ� ଡକୁ�େମ�େର ସମ� ପ�ୃ �ାର ଶୀଷ�େର ସାଧାରଣ 
େଟ�ଟ୍ େଯାଡିବାକୁ ସ�ମ କେର।  

 

(A) Footer 

(B) Header   

(C) Dropcap 

(D) Wordwrap 

[OSSC CGL Exam 2022] 

 

Ans- B 

 

A header is a section of a document that appears at the top of each 
page and contains information such as page numbers, document title, 
author name, company logo, and other relevant details. 

ଶୀଷ�କ େହଉଛି ଏକ ଡକୁେମ�ର ଏକ ବିଭାଗ ଯାହା �େତ�କ ପ�ୃ �ାର ଶୀଷ�େର େଦଖାଯାଏ 
ଏବଂ ଏଥ �େର ପ�ୃ �ା ସଂଖ�ା, ଡକୁେମ� ଶୀଷ�କ, େଲଖକ ନାମ, କ�ାନୀ େଲାେଗା ଏବଂ 
ଅନ�ାନ� �ାସ�ିକ ବିବରଣୀ ପରି ସଚୂନା ରହିଥାଏ । 
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7-  Which key should be pressed to start a new paragraph in MS-
Word? 

- ଏମଏସ-ୱାଡ�େର ଏକ ନୂତନ ପାରା�ାଫ୍ ଆର� କରିବା ପାଇ ଁ େକଉ ଁ key ଦବାଇବା 
ଉଚିତ୍?  

 

A) Down Cursor Key 

B) Enter Key 

C) Shift + Enter 

D) Ctrl + Enter 

[OSSSC Junior Clerk 2018] 

 

Ans- B 

 

Pressing the "Enter" key creates a new line and moves the cursor to the 
beginning of the next line, effectively starting a new paragraph. This is the 
standard way to create paragraphs in most word processing software, 
including MS-Word. 

"ଏ�ର" କୀ ଦବାଇବା  �ାରା ଏକ ନୂତନ େରଖା ସ�ିୃ ହୁଏ ଏବଂ କସ�ରକୁ ପରବ��ୀ ଧାଡ଼ରି 
�ାର�କୁ �ାନା�ରିତ କରାଯାଏ, �ଭାବଶାଳୀ ଭାବେର ଏକ ନୂତନ ପାରା�ାଫ୍ ଆର� ହୁଏ । 
ଏମଏସ-ୱାଡ� ସେମତ ଅଧ �କାଂଶ ୱାଡ� େ�ାେସସିଂ ସ��େୱୟାରେର ପାରା�ାଫ୍ ତିଆରି କରିବାର 
ଏହା ଏକ ମାନକ ଉପାୟ ଅେଟ । 
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8- Which one of these does NOT belong to MS Office? 

- ଏମାନ� ମ�ରୁ େକଉଟିଁ ଏମଏସ ଅଫିସର ନୁେହ?ଁ  

 

A) PowerPoint 

B) Excel 

C) Word 

D) Notepad 

[OSSC Junior Assistant 2022 Exam] 

 

Ans- D 

 

Notepad is a basic text editor program that comes pre-installed on 
Windows operating systems. It is a simple tool for creating and editing 
plain text files, but it does not have the advanced formatting and layout 
options of the other programs in MS Office, such as Word, Excel, and 
PowerPoint. 

େନା���ାଡ୍ େହଉଛି ଏକ େମୗଳିକ େଟ�ଟ୍ ଏଡିଟର େ�ା�ାମ ଯାହା ୱେି�ାଜ୍ ଅପେରଟିଂ ସି�ମ ୍
େର �ି-ଇନ�ଲ୍ େହାଇଥାଏ। ଏହା ସାଦା େଟ�ଟ୍ ଫାଇଲ୍ ସ�ିୃ ଏବଂ ସ�ାଦନା ପାଇ ଁଏକ ସରଳ 
ଉପକରଣ, କି� ଏଥ �େର MS ଅଫିସ ୍େର ଥ �ବା ଅନ� େ�ା�ାମଗଡୁିକର ଉ�ତ ଫମ�ାଟିଂ ଏବଂ 
େଲଆଉଟ୍ ବିକ� ନାହଁି, େଯପରିକି ୱାଡ�, ଏେ�ଲ ଏବଂ ପାୱାରପଏ�। 
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9- Which among the following is not a Video Conferencing Tool ? 

- ନି��ଲିଖ �ତ ମ�ରୁ େକଉଟିଁ ଭିଡିଓ କନଫେର�ି �ଂ ଟୁଲ୍ ନୁେହ ଁ?  

 

A) Zoom Meetings 

B) MS Teams 

C) Google Meet 

D) MS Outlook 

[Odisha High School Teacher Exam 2022] 

 

Ans- D 

 

MS Outlook is an email and calendar management software developed 
by Microsoft. It is used for sending and receiving emails, managing 
contacts and calendars, and scheduling meetings. 

MS Outlook େହଉଛି ମାଇେ�ାସ�� �ାରା ବିକଶତି ଏକ ଇେମଲ୍ ଏବଂ କ�ାେଲ�ର 
ପରିଚାଳନା ସ��େୱୟାର୍ । ଏହା ଇେମଲ୍ ପଠାଇବା ଏବଂ �ା� କରିବା, ସ�କ� ଏବଂ 
କ�ାେଲ�ର ପରିଚାଳନା କରିବା ଏବଂ େବ�ଠକର ସମୟ ନି��ାରଣ ପାଇ ଁବ�ବହୃତ ହୁଏ। 
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10- The quickest and easiest way in Word, to locate a particular 
word or phrase in a document is to use the command: 

- ଏକ ଡକୁେମ�େର ଏକ ନ�ି�� ଶ� କି��ା ବାକ� ଚି�ଟ କରିବା ପାଇ ଁଶ�ର ସବୁଠାରୁ �ତ 
ଏବଂ ସହଜ ଉପାୟ େହଉଛି କମା� ବ�ବହାର କରିବା: 

(A) Replace 

(B) Find 

(C) Lookup 

(D) Search 

[OSSSC RI Exam 2021] 

Ans- B 

To use the "Find" command in Word, you can follow these steps:  

• Open the Word document that you want to search.  

• Press "Ctrl" + "F" on your keyboard to open the "Find and Replace" 
dialog box.  

• In the "Find what" field, type the word or phrase that you want to search 
for.  

• Click on the "Find Next" button to search for the first occurrence of the 
word or phrase. 

ୱାଡ�େର "ସ�ାନ" କମା� ବ�ବହାର କରିବାକ ୁ  , ଆପଣ ଏହି ପଦେ�ପଗଡୁିକ ଅନୁସରଣ 
କରିପାରିେବ:  

• ଆପଣ ସ�ାନ କରିବାକୁ ଚାହ ଁୁଥ �ବା ୱାଡ� ଡକୁ�େମ� େଖାଲ�।  

• "ସ�ାନ ଏବଂ ବଦଳା�" ଡାଏଲଗ ବ�  େଖାଲିବାକୁ ଆପଣ� କୀେବାଡ�େର  "Ctrl" + "F" 
ଦବା�। 

• "କ'ଣ ସ�ାନ କର�" େ��େର, ଆପଣ ସ�ାନ କରିବାକୁ ଚାହ ଁୁଥ �ବା ଶ� କି� �ା ବାକ� ଟାଇପ ୍
କର�।  

•  ଶ� କି� �ା ବାକ�ର �ଥମ ଘଟଣା ସ�ାନ କରିବାକୁ "ପରବ��ୀ ସ�ାନ" ବଟନେର �ି�କ୍ 
କର�। 
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11- Which among the following print commands should be selected 
to print first 5 pages of document: 

- ଡକୁେମ�ର �ଥମ 5 ପ�ୃ �ା ଛାପିବା ପାଇ ଁ ନ�ି�ଲିଖ �ତ �ି� କମା�ମ�ରୁ େକଉଟିଁ ଚୟନ 
କରାଯିବା ଉଚିତ୍:  

 

(A) Print All 

 (B) From_to_ 

(C) Page Setup 

(D) Page Control 

[OSSSC Combined Recruitment 2022] 

 

Ans- B 

 

The "Print All" command will print all pages of the document, while the 
"Page Setup" command is used to adjust the page settings such as 
margins, orientation, and size. The "Page Control" command is not a 
standard print command in Word. 

"�ି� ଅଲ୍" କମା� ଡକୁେମ�ର ସମ� ପ�ୃ �ାଗଡୁିକ ମ�ୁଣ କରିବ, େଯେତେବେଳ କି "ପ�ୃ�ା 
େସଟଅପ"୍ କମା� ମାଜ�ନ୍, ଓରିଏେ�ସନ୍ ଏବଂ ଆକାର ପରି ପ�ୃ �ା େସଟିଂସ ୍ କୁ ଆଡଜ� 
କରିବାକୁ ବ�ବହୃତ ହୁଏ। "ପ�ୃ�ା ନିୟ�ଣ" କମା� ୱାଡ�େର ଏକ �ା�ାଡ� �ି� କମା� ନୁେହ।ଁ 
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12- In print preview, which one of the below actions cannot be 
performed? 

- �ି� �ିଭୁ�େର, ନ�ି�ଲିଖ �ତ �ିୟାଗଡୁିକ ମ�ରୁ େକଉଟିଁ ସ�ାଦିତ େହାଇପାରିବ ନାହଁି? 

 

A) Changing Margins 

B) Change orientation of page 

C) Zoom in and zoom out 

D) Edit the document 

[OSSC Junior Clerk 2022] 

 

Ans- D 

 

In print preview, you can perform the following actions:  
A) Changing margins: You can adjust the margins of the document to 
change the layout of the content on the page.  
B) Change orientation of page: You can switch the orientation of the 
page between portrait and landscape mode to change the page layout.  
C) Zoom in and zoom out: You can zoom in or out to see a larger or 
smaller preview of the page. 
�ି� �ିଭୁ�େର, ଆପଣ ନ�ି �ଲିଖ �ତ �ିୟାଗଡୁିକ ସ�ାଦନ କରିପାରିେବ:  
A) ମାଜ�ନ୍ ପରିବ��ନ କରିବା: ଆପଣ ପ�ୃ �ାେର ବିଷୟବ�ୁର େଲଆଉଟ୍ ପରିବ��ନ କରିବାକ ୁ
ଡକୁେମ�ର ମାଜ�ନ୍ ଆଡଜ� କରିପାରିେବ।  
B) ପ�ୃ�ାର ଓରିଏେ�ସନ୍ ପରିବ��ନ କର�: ଆପଣ ପ�ୃ �ା େଲଆଉଟ୍ ପରିବ��ନ କରିବାକ ୁ
େପାେ�ଟ୍ ଏବଂ ଲ�ା�େ�ପ େମାଡ୍ ମ�େର ପ�ୃ �ାର ଓରିଏେ�ସନ୍ ପରିବ��ନ କରିପାରିେବ।  
C) ଜମୁ ୍ଇନ୍ ଏବଂ ଜମୁ ୍ଆଉଟ୍: ଆପଣ ପ�ୃ �ାର ଏକ ବଡ଼ କି� �ା େଛାଟ �ିଭୁ� େଦଖ �ବା ପାଇ ଁ
ଜୁମ ୍ଇନ୍ କି� �ା ବାହାରକୁ ଯାଇପାରିେବ। 
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13- How many ways you can save a document? 
- ଆପଣ ଏକ ଡକୁେମ�କୁ େକେତ ଉପାୟେର ସ�ୟ କରପିାରେିବ?  
 
A- 3 
B- 4 
C- 2 
D- 1 
[Odisha Police SI 2022 Exam] 
 
Ans- A 
 

• By clicking File on the top left corner and then click save as after that 
browse the location where exactly you want to save on your 
computer.  

• By just pressing Ctrl + S and then browse the location where you 
want to save.  

• By pressing F12 and then browse the location where you want to 
save. 

• ଉପର ବାମ େକାଣେର ଫାଇଲ୍ �ି�କ୍ କରି ଏବଂ ତା'ପେର େସଭ୍ �ି�କ୍ କର� ଏବଂ ଏହା 
ପେର େସଭ୍ �ି�କ୍ କର� ଯାହା ପେର ଆପଣ ଆପଣ� କ��ୁଟରେର �କୃତେର ସ�ୟ 
କରିବାକୁ ଚାହ ଁୁଥ �ବା �ାନ�ାଉଜ୍ କର�।  

• େକବଳ Ctrl + S ଦବା �ାରା  ଏବଂ ତା'ପେର ଆପଣ ସ�ୟ କରିବାକୁ ଚାହ ଁୁଥ �ବା 
�ାନ�ାଉଜ୍ କର�।  

• F12  ଦବାଇ ଏବଂ ତା'ପେର ଆପଣ ସ�ୟ କରିବାକୁ ଚାହ ଁୁଥ �ବା �ାନ�ାଉଜ୍ କର�। 

 

14- In MS Word, which of the following do you use to change 
margins?  

- ଏମଏସ ୱାଡ�େର, ଆପଣ ମାଜ�ନ ପରିବ��ନ କରିବାକୁ ନ�ି�ଲିଖ �ତ ମ�ରୁ େକଉଟିଁ ବ�ବହାର 
କର�ି?  

 

A) formatting toolbar  

B) page setup dialog  box 

https://telegram.me/techofworld
https://youtube.com/techofworld
https://facebook.com/sujitkumarnaik123
https://play.google.com/store/apps/details?id=com.tech.edu
https://play.google.com/store/apps/details?id=com.tech.edu


 
 

 
 
 

    Join Us-                         

 

 

 

 

 

Download “Tech Of World” App 

 

 

 

 

 

 

WtsApp/Call- 8596976190 

 

 

 

 

 

 

ଓଡ଼ଶିାର ସମ� ପୂବର୍ ବଷର୍ର �ଶ� ଉ�ର ପାଇଁ 

 

 

 

 

 

 

C) standard toolbar 

D) paragraph dialog box 

[OSSSC Junior Clerk 2018] 

 

Ans- B 

 

In MS Word, you use the Page Setup dialog box to change margins. 
This dialog box provides options for setting margins, orientation, paper 
size, and other page layout settings. To access the Page Setup dialog 
box, you can either click on the Page Setup launcher in the Page Setup 
group on the Page Layout tab, or go to the File menu, select Page 
Setup, and then select the Margins tab. 

MS ୱାଡ�େର, ଆପଣ ମାଜ�ନ୍ ପରିବ��ନ କରିବାକୁ ପ�ୃ �ା େସଟଅପ ୍ଡାଏଲଗ ୍ବ� ବ�ବହାର 
କର�ି। ଏହି ଡାଏଲଗ ବ� ମାଜ�ନ୍, ଓରିଏେ�ସନ୍, କାଗଜ ଆକାର ଏବଂ ଅନ� ପ�ୃ �ା 
େଲଆଉଟ୍ େସଟିଂସ ୍ େସଟ୍ କରିବା ପାଇ ଁ ବିକ� �ଦାନ କେର। ପ�ୃ �ା େସଟଅପ ୍ ଡାଏଲଗ ୍
ବ�ଆକେସସ ୍କରିବାକୁ, ଆପଣ ପ�ୃ �ା େଲଆଉଟ୍ ଟ�ାବ୍ େର ପ�ୃ �ା େସଟଅପ ୍ଗରୁ୍ପ ୍େର ଥ �ବା 
ପ�ୃ �ା େସଟଅପ ୍ ଲ�ର୍ ଉପେର �ି�କ ୍ କରିପାରିେବ  , କି� �ା ଫାଇଲ୍ େମନୁ�କୁ ଯାଇ, ପ�ୃ�ା 
େସଟଅପ ୍ଚୟନ କରିପାରିେବ, ଏବଂ ତା'ପେର ମାଜ�ନ୍ ଟ�ାବ୍ ଚୟନ କରିପାରିେବ। 

 

15-  What programme is used in MS Word to check the spellings? 

 - ବନାନ ଯା� କରିବା ପାଇ ଁଏମଏସ ୱାଡ�େର େକଉ ଁେ�ା�ାମ ବ�ବହାର କରାଯାଏ?  

 

(A) Outlook Express  

(B) Spell-check 

(C) Speller 

(D) None of above 

[OSSSC Combined Recruitment 2022] 
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Ans- B 

 

• In MS Word, the program used to check spelling is called "Spelling and 
Grammar Checker".  

• To use the Spelling and Grammar Checker, you can either click on the 
"Spelling and Grammar" button in the Proofing group on the Review tab, or 
press "F7" on your keyboard. 

• ଏମଏସ ୱାଡ�େର, ବନାନ ଯା� କରିବା ପାଇ ଁ ବ�ବହୃତ େ�ା�ାମକ ୁ "େ�ଲିଂ ଏବଂ ବ�ାକରଣ 
େଚକର" କୁହାଯାଏ ।  

• େ�ଲିଂ ଏବଂ ବ�ାକରଣ େଚକର ବ�ବହାର କରିବାକୁ, ଆପଣ  ସମୀ�ା ଟ�ାବ୍ େର ଥ �ବା ପରୁ୍ଫିଂ 
ଗରୁ୍ପ ୍ େର ଥ �ବା "େ�ଲିଂ ଏବଂ ବ�ାକରଣ" ବଟନେର �ି�କ ୍ କରିପାରିେବ, କି� �ା ଆପଣ� 
କିେବାଡ�େର "F7" ଦବା�। 

 

16- In MS Word, which shortcut key is used to print a document? 

- ଏମଏସ ୱାଡ�େର, ଏକ ଡକୁେମ� ଛାପିବା ପାଇ ଁେକଉ ଁସଟ�କଟ୍ key ବ�ବହାର କରାଯାଏ? 

 

(A) Shift + P 

(B) Alt + P 

(C) Tab + P 

(D) Ctrl + P 

[Odisha Police ASI 2022] 
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• In MS Word, the shortcut key used to print a document is "Ctrl + P". This 
keyboard shortcut opens the Print dialog box, where you can choose the 
printer, set print options such as number of copies, page range, and paper 
size, and then print the document. 

• This shortcut is often quicker than going to the File menu and selecting 
Print, or using the Print button on the Quick Access Toolbar. 

• ଏମଏସ ୱାଡ�େର, ଏକ ଡକୁେମ� ଛାପିବା ପାଇ ଁବ�ବହୃତ ସଟ�କଟ କୀ େହଉଛି "Ctrl + P"।  
ଏହି କୀେବାଡ� ସଟ�କଟ୍ �ି� ଡାଇଲଗ ୍ ବ� େଖାଲିଥାଏ, େଯଉଠଁାେର ଆପଣ �ି�ର୍ ଚୟନ 
କରିପାରିେବ, କପି ସଂଖ�ା, ପ�ୃ �ା ସୀମା ଏବଂ କାଗଜ ଆକାର ଭଳି �ି� ବିକ� େସଟ୍ କରିପାରିେବ 
ଏବଂ ତା'ପେର ଡକୁେମ�କୁ �ି� କରିପାରିେବ। 

• ଫାଇଲ୍ େମନୁ�କୁ ଯାଇ �ି� ଚୟନ କରିବା କି� �ା �ିକ୍ ଆେ�ସ ୍ ଟୁଲବାରେର �ି� ବଟନ୍ 
ବ�ବହାର କରିବା ଅେପ�ା ଏହି ସଟ�କଟ୍ ଅଧ �କାଂଶ ସମୟେର ଶୀ� େହାଇଥାଏ। 
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